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Installing ABBYY FlexiCapture 9.0

Before purchasing the product, analyze your document processing needs and select either the local or the distributed version.

If you plan to process moderate amounts of documents (approximately 5,000 pages per day), employ one or two operators for the job,
and do not require any sophisticated batch routing, then Local Installation is the best choice.

If you plan to automate data capture and processing, require sophisticated batch routing based on document or batch types, and need
a scalable pool of centrally administered workstations, then select Distributed Installation.

Important! The distributed and local versions cannot be installed on the same computer.

Standalone Installation
To install the standalone version of ABBYY FlexiCapture:

1.
2.
3.

10.

Notes.

Place the ABBYY FlexiCapture 9.0 CD-ROM into the CD-ROM drive.
In the Autorun menu, select Standalone Installation (or run the setup.exe file located on the CD-ROM).

Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages
are incompatible, a warning message is displayed.

Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If
the version of the operating system is not supported by the program or you do not have the administrative permissions, a
warning message is displayed and the setup program is terminated.

If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement care-
fully and if you agree with the terms of the agreement, select the corresponding option and click Next.

A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

In the next dialog box, select one of the available installation modes:

Administrator Station — The setup program installs the Administrator Station, FormDesigner 9.0, and FlexiLayout Studio
9.0.

Operator Station — The setup program installs only the Operator Station. (The Administrator Station, FormDesigner 9.0
and FlexiLayout Studio 9.0 will not be installed).

Next, select a destination folder. By default, the program is installed to %:\Program Files\ABBYY FlexiCapture 9.0. If
there is not enough space on the selected hard disk, a window is displayed showing your hard disks, the available free space,
and the space required by the installation. Select a disk with sufficient free space and continue with the installation.

The program files will be copied onto your computer. Once the installation is finished, the setup program will display a mes-
sage saying that the application has been successfully installed.

FlexiCapture 9.0 License Manager will be launched automatically so that you can activate your serial number. See the
Managing Licenses section for details.

The system can be installed on a workstation in one mode only: as the Administrator’s station with additional tools or as the
Operatot’s station.

For information about configuring multiple workstations to work with a single license setver, see “Connecting stations to the
Protection Server”.

Distributed Installation
The following three steps are required to install the distributed version of ABBYY FlexiCapture:

1.
2.
3.

Prepare the Application Server.
Install the servers.

Install the workstations.

Preparing the Application Server
The distributed version of FlexiCapture 9.0 includes three servers:

Application Server



. Protection Server

. Processing Server

The Application Server coordinates the work of the stations ensures the correct operation of ABBYY FlexiCapture 9.0. The following
components must be installed on your computer before you can install the Application Server:

«  Net Framework 2.0 or later

This component, together with a number of other components, can be installed by selecting Install External Components in the Auto-
run menu.

« 1IS (Internet Information Services)
Several IIS versions are available:

« 5.1 for Windows XP

« 6.0 for Windows 2003

« 7.0 for Windows Vista & 2008

Windows XP and Windows Vista are not server operating systems. They support only a limited number of connections and are not very
suitable for server use. For the Application Server, Windows 2003 in conjunction with IIS 6.0 is recommended.

To install TIS, select Add or Remove Programs->Add/Remove Windows Components.

_ioix
- -

Currently installed programs: [T show updates Sork by Imame j
5 Microsoft \NET Framework 1.1 Size  36,15ME &
ﬁ_%! Microsoft JMET Framework 2.0 Service Pack 2 Size  184,00ME

ﬁE‘ﬁ Microsoft \MET Framework, 3.0 Service Pack 2 Size  169,00ME

ﬁl Microsoft (MET Framework 3.5 SP1 Size  28,23MB

ﬁEﬂ Microsoft Device Emulator version 1.0 - EMU Size 1,35ME J
ﬁ! Microsoft Document Explorer 2005 Size  26,61ME

@ Microsaft Firewall Client Size 0,75ME

E:’, Microsoft Office 2003 Russian User Interface Pack Sige  137,00MB  _

© 2009 ABBYY. All rights reserved. 5



Windows Components Wizard L

Windows Components
Yau can add ar remaove companents af Windows =P

To add or remove a companent, click the checkboy, & shaded box means that anly
part of the component will be installed. To zee what's included in a companent, click

Detailz.
Components:
[ & Indexing Service 00ME =]
._'7__.@ Internet Explarer 0.0 ME

( % Internet Information Services [115] 135 B jJ
] Eﬁ] tanagement and Monitaring Tools 2.0 B
[ m2 Messane Nuesinn M1 MR ;I

Descrption:  Includes Windaows Acceszories and Likilities for vour computer.
Total dizk space required: AE.2 MB Biiaie |
Space available on disk: T1671.7 ME i

< Back I Meut = I Cancel |

During installation, Windows may require files from the setup disk, therefore be sure to have the Windows disk ready at hand.
If you install the Application Server on Windows Vista or Windows 2008 (IIS 7.0), select the following additional IIS components:
-> Web Management Tools
-> IS 6 Management Compatibility
-> 1IS 6 Metabase and IS 6 configuration compatibility
->1IS 6 Scripting Tools
->World Wide Web Services
-> Application Development Features
-> ASPNET
-> ISAPI Extensions
-> Common HTTP Features
-> Static Content
-> Security
-> Windows Authentication

If any of the components is missing on your computer, the setup program will display a warning message and the installation of the
Application Server will stop.

Once the installation is complete, open the Administrator Console and make sure that the IIS service is running,

Important! In Windows 2003 ASP.NET is disable by default for security reasons. This will cause “Error 404 File not found” when you
attempt to start the Monitoring Station. To solve the problem, allow the ASP.NET v2.0 service extension in the IIS Manager:




E Computer Management

=101 x|

EI--& Srvices and Applications
B Telepharey

Services
545 WML Conkrol

B Indexing Setvice
E"Fg Internet Information Services (115) Manager

| Application Pocls

| Web Sites
(__'_J “Weh Service Extensions

£ add 5 new web service extensin...

& allow oll web service extensions For a

specific application...

Il protibit all web service extensions

@ Open Help

Q File  Action  Wiew  Window  Help | =11
- @ FRAB 2L =0
Q Computer Management: (Local) @ web Service Extensions
L——_Im System Tools
[]"@ Event Viewer /| web Service Extension | status |
D'"% Shar;ad Foldersd “F Al Unknown CGI Extensions Prohibited
2 Local Users and Groups i
Prohibited
&% Performance Logs and Alerts oy ] Brahibited
-3 Device Manager Prohibit Fromiied
¥ Storage - i
% =5 Rgmovable Starage Froperties | Inkernet Data Connector Prohibited
=
= Disk, Defragmenter Server Side Includes Prohibited
5 Dk Management ke YebDAY Prahibited

Extended A Standard /

This service extension will appear in the list only after you install NET Framework 2.0.
If your computer runs Windows 2003 (64-bit) or Windows XP (64 bit), do the following:

4.

W3SVC/AppPools/Enable32BitAppOnWin64 true

5.

World Wide Web Publishing Properties {Local C

General | Log EInI Hecoveryl Dependenciesl

Semnice name:
Drigplay name:

Descriphion:

Fath to execut

WISV

Execute the following command from the command line: cscript C:\Inetpub\AdminScripts\adsutil.vbs set

Make sure that the World Wide Web Publishing service is running in 32-bit mode:

Frovides Web connectivity and adminiztration
throwgh the Internet Information Services snap-in

=

[]

il DD'W'ﬁ'xa_l,lstem32'\hetsw'\inetinfu. ae

Startup tppe:

I.-'-\utu:umatic

[

Semnvice status

Stkart |

Started

Stop | Pauze

Hesume |

Y'ou can specify the start parameters that apply when you start the zervice

from here.

Start parameters:

o |

Cancel

Apply

6.

Execute the following command from the command line:

C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe —i




7. The list of IIS service extensions (see below) will now include an entry for the 32-bit version of ASP.Net. Change its status to

allowed:

'IE Internet Information Services (I1S) Manager

‘:g File  Ackion  Wiew  window  Help

e |mEFEB|22]r 50

?_a Inkernet Information Services . weh Service Extensions
-0 GROMIT-2K3-64 (local com

El_.J Application Pools # | Wb Service Extension
E‘—-J b SItBS. : i all Unknown CGI Extensions
[ Wb Service Extensior Al & allunknown ISAPT Extensions

@ Active Server Pages

Frahibit
Properties SPOMET w2,0,50727 (32-hit)
FlexiCapture Web Services
@ Internet Data Conneckor
Tasks @ Server Side Includes

48 webDav

Add a new Web service extension. ..

Allow all Web service extensions for a
The following components are required for the correct operation of the system

. The Application Server requires MS SQL Server 2005 or 2008. Mixed Mode must be enabled ("SQL server and Windows au-

thentication") for authentication purposes.

The ABBYY FlexiCapture 9.0 disk includes MS SQL Server 2005 Express, which can be used for demonstration purposes and

for smaller projects, as it limits the size of the database to 4 GB.

If MS SQL Server 2005 or 2008 is already installed on your computer, you can use the installed version.

. Crystal Reports

This component is used by the Administration and Monitoring Console to print out reports. Crystal Reports can be installed
on the same computer where the Application Server is installed. Without this component, you will not be able to print out

reports. However, all other Application Server management functionality will be available.

Important! Before installation, make sure that the Microsoft Distributed Transaction Coordinator runs under the account NT

AUTHORITY\NetworkService:

Distributed Transaction Coordinator Properkie: x|

General LogOn |Hecovery Dependencies

Log on az

 Local System account

™| Allows service tojinteract with deskiop

(INT AUTHORITY\MetworkSery } Browse...

PaSSWD[d: I...............

Confirm password: Iooooooooo.oo.o-

You cah enable or dizable thiz gervice for the hardware profiles lizted below;

Hardware Prafile | Service |
Profile 1 Enabled
Enatle | Disable |

0k I Cancel | Apply

Installing the servers
Once you have made the preparations for installing the Application Server, install the servers.



By default, all servers are installed on the same computer. However, you can install them on different computers by disabling the re-
dundant servers in the setup program.

To install the ABBYY FlexiCapture servers:

1.
2.

11.

12.

In the Autorun menu, select Distributed Installation. Next, select Install Servers to start the installation.

Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages
are incompatible, a warning message is displayed.

Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If
the version of the operating system is not supported by the program or you do not have the administrative permissions, a
warning message is displayed and the setup program is terminated.

If all the checks are passed successfully , the end-user license agreement will be displayed. Read the license agreement care-
fully and if you agree with the terms of the agreement, select the corresponding option and click Next.

A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

Next, select a destination folder. By default, the program is installed to: %:\Program Files\ABBYY FlexiCapture 9.0 Serv-
ers

Select the servers to install:
Processing Server — the server that controls the operation of the Processing Stations

Protection Server — the server that stores and manages licenses. When you install stations, you must specify the address of
the Protection Server in the format server, without \\

Application Server — the server that controls the operation of the other components

Stations Installer — selecting this option will copy the stations’ setup files onto the Application Server so that you can then
deploy them from the server. SMS and Active Directory deployment are supported. Once you select this component, you can
specify the destination folder where to copy the setup files.

Next the setup program will check if Net Framework 2.0 and IIS are installed on your computer.

If any of the components is missing on your computer, the setup program will display a warning message.

. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a mes-

sage saying that the application has been successfully installed.

Once the installation is complete, FlexiCapture 9.0 License Manager will be launched automatically so that you can acti-
vate your serial number. See Managing Your Licenses section for details. The Monitoring Station will also be launched, where
you can set up the installed Application Server.

Reboot your system for the changes you have made to the IIS settings to take effect.

IMPORTANT! The Application Server should be published to the Internet if you wish to use the remote stations over the Internet.

Installing the stations
The following installation methods are available to install the stations:

manually (interactive installation)
from the command line
using Active Directory

using Microsoft Systems Management Server (SMS)

The automated installation methods give you speed and flexibility when installing ABBYY FlexiCapture 9.0 on a local area network, as
you do not have to install the program manually on each individual workstation.

Manual (interactive) installation
To install ABBYY FlexiCapture stations:

1.

DSWw

Install the ABBYY FlexiCapture CD-ROM into the CD-ROM drive.
In the Autorun menu, select Distributed Installation.
Select Install Workstations to start the installation.

Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages
are incompatible, a warning message is displayed.



5. Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If
the version of the operating system is not supported by the program or you do not have the administrative permissions, a
warning message is displayed and the setup program is terminated.

6. If all the checks are passed successfully , the end-user license agreement will be displayed. Read the license agreement care-
fully and if you agree with the terms of the agreement, select the corresponding option and click Next.

7. Adialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

8. Next, select a destination folder. By default, the program is installed to: %:\Program Files\ABBYY FlexiCapture 9.0 Sta-
tions

9. In the next dialog box, provide the address of the Protection Server. The Protection Server is installed via server installation.
The address should not contain slashes, for example: MainServer

10. Select the stations to install:

- Scanning Station scans documents and sends them to the server for further processing

. Processing Station automatically recognizes, imports, and exports documents; controlled by the Processing Server
. Project Setup Station is used to set up projects on the server

«  Data Verification Station is used to verify data

«  Verification Station is used to verify data, correct document assembly errors, handle exceptions

«  FlexiCapture Studio is a tool for creating FlexiLayouts

. FormDesigner is a tool for creating forms
Just like the servers, the stations can be installed on the same or on different computers.
11. IfaProcessing Station is selected, a dialog box will appear where you must select the account under which the Processing
Station service will run. By default, the service runs under the user NETWORK SERVICE. If you plan to import/export data on

this station from/to a storage location with restricted user rights, or if this station is not in the domain, you can specify the
user that has the appropriate rights. In this case, the Processing Station service will run under this user.

12 . The program files will be copied onto your computer. Once the installation is finished, the setup program will display a mes-
sage saying that the application has been successfully installed.

Command line installation

In the default configuration, all recognition languages are installed on the local computer and the interface language is selected auto-
matically based on the regional settings of the computer on which the program is installed. All stations are installed, and the network
name of the computer from which the setup program is run is used as the Protection Server (in the case of standalone installation,
localhost is specified). The default user becomes the user of the Processing Station.

Run the setup.exe file located in the administrative installation folder using the command line options described below.

Advertise installation
For advertise installation, type
Setup.exe /j

The program icon will appear in the Start menu of the workstation. Clicking this icon automatically installs the program in default
configuration.

Silent installation

In the case of silent installation, no setup dialog boxes are displayed and the program is installed in default configuration.
Setup.exe /qn

Change “/qn” to “/qb” if you want an installation progress bar to be displayed.

No other dialog boxes will be displayed.

Additional command line options

/L<language code> disables auto selection of the interface language and installs the program with the interface language you specified.
The following language code values are available:

1033 English

1049 Russian

1031 German

1036 French

2052 Chinese simplified

10



1040 Italian
1034 Spanish

/V <command line> passes the specified command line directly to msiexec.exe. The <command line> string can be replaced with
the following commands:

INSTALLDIR="<destination>" — the path to the folder where ABBYY FlexiCapture 9.0 is to be installed.
STATIONS=0,1,2,3,4,5,6 — the list of stations to install.

The numbers 0 to 6 correspond to the following stations:

0 - Scanning Station

1 — Processing Station

2 — Verification Station

3 — Data Verification Station

4 — Project Setup Station

5 - FlexiLayout Studio

6 - FormDesigner

ACCOUNTTYPE=Custom, LOGIN=user name, PASSWORD=password

You can specify an account under which to run the Processing Station service.

Example:

Setup.exe /qn /L1049 /v INSTALLDIR="D:\FC90" STATIONS=14 ACCOUNTTYPE=Custom
LOGIN=Domain\UserLogin PASSWORD=PSWD

As a result, the Processing and Project Setup Stations will be installed into D:\FC90, and Russian will be used the language of the inter-
face. The Processing Station service will run under the account Domain\UserLogin and the password will be PSWD.

Removing ABBYY FlexiCapture in silent mode
msiexec /x {FC90000C-0001-0000-0000-074957833700}

Using Active Directory

Microsoft© Windows© 2000 Server and Microsoft© Windows© 2003 Server include an integrated directory service, Active Direc-
tory, which in turn includes Group Policy. The Software Installation snap—in, which is part of Group Policy, allows you to install a
software application on several workstations simultaneously.

Three major installation methods are implemented in Active Directory: Publish to User, Assign to User, and Assign to Com-
puter. ABBYY FlexiCapture 9.0 can be installed using the Assign to Computer method. ABBYY FlexiCapture 9.0 will be installed on
the specified workstation after the workstation is restarted.

The Publish to User and Assign to User methods are not supported.

When deploying ABBYY FlexiCapture 9.0 using Active Directory®, the account of the computers in the Domain Computers domain
must have read right to the administrative installation folder.

Example: Deploying ABBYY FlexiCapture 9.0 using Active Directory
The program is installed on one domain computer or on a group of domain computers:

1. During Setver Installation, install the Station Installer. If you did not install the Station Installer when installing the Applica-
tion Server, install the Station Installer by selecting Control Panel->Add or Remove Programs->Change.

2. Select Start->Control Panel->Administrative and then select the Active Directory Users and Computers item.

11



£# Active Directory Users and Computers

<7 Fle  Action Wiew Window Help

=101 x|

| =181]

«=» amEerPRB R adavs e

@ Ackive Directory Users and Computer | gag.ru 10 objects

@ Computers [ZDomain Controlers Organizational ...
&3] Domain Controllers

D ForeignSecurityPrincipals ClFnreignSecurityPrincipaIs Container
23 Lastandround [JLastandround loskandFaund
L3 NTDS Quatas [CINTDS Quotas msD5-QuotaCo. .,
(23 Program Data [CdProgram Data Container
23 system [D=ystem Conkainer
-2 Users [(Ausers Zonkainer
InFrastructure infrastructurel, .

l | a3

D Saved Queries Mame | Twpe | Description |
g _ [ Buitin builtirDormain
=11 Builin [CAComputers Container Default container For upar...

Defaulk conkainer For dom. ..
Default container for secu, ..
Default container For arph, ..
Zuota specifications cont, .
Default location for storag...
Builtin syskem settings
Default container For upagr. ..

3. Right—click the site, domain, or another organized unit that contains the computer or group of computers onto which
ABBYY FlexiCapture 9.0 is to be installed.

-.‘.'_4" Active Directory Users and Computers

@ File  Action  Miew  Window  Help

=101

JRETE

- OmE R FRE @ afhvgy

@ Active Directory Users and Computer | gag.ru 10 objects

| Descripkion

Mew Window From Here

Refresh
Expork List., ..

Properties

Help

l | |

Default conkainer For upgr.,.
Default container For dom..,
Default container For secu. ..
Default conkainer For orph, ..
Quata specifications cont.,.,,

Default location For skorag,..,

Builtin system settings

Defaulk conkainer Far upar. ..

i+ Saved Queries Marne | Type
EH-\:L: Delegate Contral,,, builtinDaomain
: Find... rs Container
Connect ko Damain. ., Controllers Crganizational ...
Connect to Domain Conkroller. . ecurityPrincipals Container
Raise Domain Functional Lewel... Found lastandFaund
Cperations Masters, ., otas msDS-Cuokaca..,
B Hew ' Data Cnntainer
ol Al Tasks i Cnnta!ner
Container
Wiew k lickure infrastructurel, ..

4. On the shortcut menu, select Properties and click the Group Policy tab:

© 2009 ABBYY. All rights reserved.
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Generall Managed B_I,II Elbiectl Security  Group Policy |

Toimprove Group Policy managemen
M anagement Consale [GPMEC).

i
Currenit Group Palicy Object Links for gag
—

Group Policy Object Links | Mo Override | Dizabled |
Default Damain Policy

0 the Group Policy

Group Paolicy Objects higher i the list have the highest priority.
Thiz lizt obtained from: ShadowDC qag.m

Hew | agd. | Edi | i

Dptiong... | Delete... | Froperties | Do |

[ Block Palicy inheritance

ok I Cancel | Spply |

Click New, enter a descriptive name, and click OK.

Right-click the Group Policy Object you have created and select Edit...

~N o !

In the Group Policy window, right-click Computer Configuration/Software Settings/Software Installation.

8. On the shortcut menu, select New/Package.

'fiii Group Policy Object Editor B o] [

File  Action Wiew Help

_E-j FlexiCapture 5.0 license edition [5F | Mame | Wersinn | Deployment state | Source |
E| @ Computer Configuration h : by in Ehis i
== |:| Saftware Settings There are noikems to show in Ehis wiew,

----- = SRS T oo |

7] Windows Setting:
i B Administrative Te Yiew 3
Elﬁ ser Configuration ————
; 7] Software Setting Baste

23 Windows Setting:  Refresh

B+ Administrative Te  Expart List..,

Properties

Help

of | |

|Creates a new object in this container,

© 2009 ABBYY. All rights reserved.
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9. Provide the path to the file ABBYY FlexiCapture 9.0 Stations.msi, which is located in the administrative installation

folder on the server.
10. Select the Advanced deployment method.
Select deplopment method:
7 Bublished
" Assigned
@ Advanced

Select thiz option to configure the Publizhed or Assigned options,
and to apply modifications o a package.

(] I Cancel |

11. Inthe dialog box that opens, click the Modifications tab and then click the Add button.

ABBYY FlexiCapture 8.0 Professional Properties 7] =]
General | Deployment Upgradesl Categories  Modifications | Seu:urityl

Maodifications ar transfarmz allow vau b custamize the package and are
applied to the package in the arder shown in the following lizt:

Modifizations:

"-."-.:E:h.E||:||:|l.-'-.ll:ll::"-."-.-" .

i owe lp

fil e [ ot |

Remove |

[mpartant! Do not press OF until all tranzforms are added and ordered

cormecty. For more information, nght-click on the Modifications list box, and
then click ‘What's this?

k. Cancel

12. Select the interface language to be used in ABBYY FlexiCapture 9.0. The language files are located in the administrative instal-
lation folder on the server.

The list of available files and their corresponding languages:
1033.mst English
1049.mst Russian

Using SMS

Microsoft Systems Management Server automates software deployment and eliminates the need to go directly to the locations where
the software is to be installed (computers, groups, ot setvers).

SMS deployment includes the following three stages:

1. Creating an ABBYY FlexiCapture 9.0 deployment package.

14



2. Creating a deployment script (contains installation parameters: names of computers, time of installation, conditions for in-
stallation, etc.).

3. Deployment of the program on the workstations by SMS based on the script settings.

Example: Deploying ABBYY FlexiCapture 9.0 using Microsoft SMS
1. When installing the Application Server, create an installation package for ABBYY FlexiCapture 9.0 stations.
2. In the SMS Administrator console, select the Packages node.

3. Inthe Action menu, select New/Package.
L8[

File  Action Miew Help

- |mEaB| 2

E iSystems Management Server | HETE
EC@ Site Datahase (001 - Abbyy) Site Database {001 - Abbyy)

- Site Hierarchy

[]-- Collections

Packopagy
Eﬂ Adver OPEN |

D"% Repot = nllTasks b Package From Definition

- Querin  Prnt
@ Softw Refresh

Sacir] Properties
- Tonls Help
Onlines e

|Select this item to create a new SMS Package.

|
i start J @ 9 J n& sms - [Systems Mana... J | g &%i{ 18:09

4. Inthe Package Properties dialog box, fill out the required fields.

© 2009 ABBYY. All rights reserved.
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ABBYY FlexiCapture 9.0 English Package Properkies

Diistribution Settings I Feporting I
General | Data Source I

ﬁ I.&EBW FlexiCapture 9.0 Englizh

2]

Security
D ata Access

Change [con... |

M ame: FlexiCaptre

Werzion: IEU:I

Publisher: I-"-"-B B

Language: IEninsh

Comment: ;I
[

ITI Cancel Spply Help
Click the Data Source tab.

Make sure that This package contains source files is cleared and click OK.

Expand the node of the newly created package and select Programs.

In the Action menu, select New/Program.

© 2009 ABBYY. All rights reserved.
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B
=@

E]--%
&

"
[]..Ca

'3

3, Collections

=8

E Systems Management Server Tame | Run Time (hh:mm) | Disk Space | Comment |
- Site Database (001 - Abbyy)

Site Hierarchy There are no items ko show in this view,

Packages
g ABBYY ABBYY FlexiCapture 8.0 English

fff Arress Arcounts
Distribution Points

Advertisement  2Pen |

Software Mete e
Reporting
Product Compli ¥iew »
Queries e
Print
Software Updz o
Refresh
System Status i
Security Rights Sl
Tools Help

Online Library

|Creates a new object in this container. |

| Start

9.

10.

11.
12.

W 2

J @ Q J ﬂ My Documents ”n& sms - [Systems Mana... E unkitled - Paint | J w

In the Program Properties dialog box, click the General tab and on this tab:

In the Name field, type a descriptive name of the program
In the Command Line field, type setup.exe /q

In the Start in field, provide the network path to the ABBYY FlexiCapture administrative installation folder (e.g.
\\MyFileServer\Programs Distribs\ABBYY FlexiCapture 9.0).

In the Program Properties dialog box, click the Environment tab and on this tab:
Clear the User input required option

Select the Runs with administrative rights option

Make sure that the Run with UNC name option is selected

Adjust the running parameters if required and click OK.

You can also use the Distribute Software Wizard. In the Action menu of the package, select Distributive Software and

follow the instructions of the wizard.

© 2009 ABBYY. All rights reserved.
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Distribute Software Wizard x|

YWelcome to the Distribute Software
Wizard

Thiz wizard helps you diztribute zoftware to clients.

Y'ou can zelect or create a zoftware package and copy the
package ta diztribution points an your network.

'ou can then advertize a program to collections that clients
are memberzs of, ar create a new callection to advertize the
program o

To distribute software, click Mest.

< Black

Cancel |

Important! You cannot create Distribution Points.

Installing a Remote Stations

If the workstation of the Scanning or Data Verification Operator is not part of the LAN, a regular stations will not be able to connect to
the Protection Server.

Use Remote Stations in this case. Remote Stations can connect to the Application Server via HTTP.
To install a Remote Stations:

1.

DSW

Insert the ABBYY FlexiCapture 9.0 CD-ROM into the CD-ROM drive. The setup program will start automatically.
Select Distributed Installation.
Select Install Remote Scanning Station or Install Remote Data Verification Station.

Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages
are incompatible, a warning message is displayed.

Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If
the version of the operating system is not supported by the program or you do not have the administrative permissions, a
warning message is displayed and the setup program is terminated.

If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement care-
fully and if you agree with the terms of the agreement, select the corresponding option and click Next.

A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

Next, select a destination folder. By default, the program is installed to: %:\Program Files\ABBYY FlexiCapture 9.0
Scanning Station\ or %:\Program Files\ABBYY FlexiCapture 9.0 Data Verification Station\. If there is not enough
space on the selected hard disk, a window is displayed showing your hard disks, the available free space, and the space re-
quired by the installation. Select a disk with sufficient free space and continue with the installation.

The program files will be copied onto your computer. Once the installation is finished, the setup program will display a mes-
sage saying that the installation has completed successfully.

IMPORTANT! The Application Server should be published to the Internet if you wish to use the remote stations over the Internet.
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Managing Your Licenses

After you install the program, you need to activate your serial number. This section describes the use of ABBYY FlexiCapture 9.0 Li-
cense Manager, the license management utility supplied with ABBYY FlexiCapture 9.0.

Overview

ABBYY FlexiCapture 9.0 License Manager is a license management utility. It is installed on the Protection Server when the server
are installed.

The License Manager allows you to:
« add new licenses
. activate licenses
. view license parameters

. select and enable licenses
Hardware licenses are activated in the same way as software licenses.

ABBYY FlexiCapture 9.0 License Manager
The main License Manager window contains the following columns:
«  Serial number - displays the serial number of the license

. License parameters — displays the parameters of the license
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T ABBYY FlexiCapture 9.0 License Manager

License Service Help

Serial DVRP-9010-0000-4642-6562-3657 chaose... ]
License parameters
General A~
Serial number DWRP-0010-0000-4642-65362-2657 —
Protection type software
Working on virtual machine yes
License purpose
License type trial
Business process outsourcing service (BPQ) no
Work stations
Station types for Distributed
Scanning stations total: 5 free: 5
Verification stations total: 5 free: 5
Setup stations total: 5 free: 5
Data verification stations total: 5 free: 5
Processing stations unlimited
Monitoring stations unlimited

Tools
FlexiLayout Studio total: 1 free: 1
FormDesigner total 1 free: l
Time
Expiration date 15.08.2009 11:00:00
Performance
Page limit
total 30000
available: 79431
Renewsahle every never
CPU cores unlimited
Processing B
FlexiLayouts yes
Number of fields unlimited
Languages (OCR)
Chinese Wes
Karean yes
Japanese yes
Thai yesg
Vietnamese yes w
Parameter description
License properties
Property Description
Serial number Unique license number.
License parameters «  General - the serial number, licensing method, ability

to use a virtual machine

License purpose — type of license (software or hard-
ware), ability to provide document processing services

Work stations, Tools - restrictions on the number of
stations in the system and the use of development tools
(FlexiLayout Studio, FormDesigner).

Time, Performance - restrictions on the use of
ABBYY FlexiCapture 9.0.

Processing — additional document processing parame-
ters: use of FlexiLayouts, use of additional recognition
languages

Custom components (including document defi-
nitions) — use of components created by users

Import — additional import capabilities
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. Export - additional document and image export ca-
pabilities

To view all the available licenses, click Choose... or select License->Show all licenses... to open the Licenses window (if no li-
censes are available, an Add license... button is displayed instead of the Choose... button):

¥ Licenses

Serial number Protection type
L¥4 DVRP-9010-0000-4642-6562... License file

Status

Expiration date
15.08.2009 11:00:00

Serial number
Protection type

Business process outsourcing service (BPO)
Work stations
Station types for Distributed

Scanning stations

4

DVRP-9010-0000-4642-6562-3657
software

total: 5 free: 5

4 >
Hide parameters << l Activate... l l Update... l l Deactivate... Se
Parameter Value Description ‘B
General

Hardware or software
Is working on virtual machine allowed

Working on virtual machine Yes
License purpose
License type rial General, trizl or not for resale

no Right to use FlexiCapture for BPO sevices

Count of scanning stations that can work |«

>

(4] Synchronize

Close

License statuses

License statuses

«  Activated (the license had been activated)

. Expired (the license had expired or the page limit has been reached)
The current (i.e. active) license has a v next to it and is highlighted in bold.

Buttons in the License window

¥ Licenses

Serial number
[¥4 DVRP-9010-0000-4642-6562....

Frotection type Status
License file

Expiration date

15.08.2009 11:00:00

Work stations

Station types for Distributed
Scanning stations

<

Business process outsourcing service (BPO)

total: 5 free: 5

< >
Hide parameters << l Activate... l l Update... l l Deactivate...
Parameter Value Description ‘B
General
Serial number DVRP-9010-0000-4642-6562-3657 B
Protection type software Hardware or software
Working on virtual machine Yes Is working on virtual machine allowed
License purpose
License type rial General, trial or not for resale

no Right to use FlexiCapture for BPO sevices

Count of scanning stations that can work |«

>

Close

Hide parameters<< (License parameters>>) — hides (shows) the detailed information about the selected license

(W} Synchronize

Activate... - launches the ABBYY FlexiCapture Activation Wizard
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. Update.. - refreshes the information about the activated license

. Deactivate... - deactivates a license

. Select - makes the selected license current (i.e. active)

. Synchronize - refreshes the information about the licenses available on the Protection Server

«  Close - closes the Licenses window

Activating a license

ABBYY takes steps to protect its intellectual property from piracy. Software piracy is harmful both to manufacturers and to end users
alike. Unlike legally purchased software products, pirated software is never safe and secure.

If your end-user license agreement allows you to install and use the product only one computer, installing it on several computers will
breach the agreement and violate the copyright laws of the Russian Federation. The activation technology restricts the number of soft-
ware copies that can be used simultaneously and thus prevents the installation of one licensed copy on an unlimited number of com-
puters. At the same time, one licensed copy may be installed and activated on one and the same computer any number of times with-
out any restrictions.

You will not be able to use the software product unless you activate it.

ABBYY FlexiCapture 9.0 license activation wizard

Enter your senal number:

Mext = I l Cancel

How activation is carried out?

The activation process takes very little time and is carried out via an activation wizard. The activation wizard helps you to send the
data required for activation to ABBYY. These activation data are sent to ABBYY in the form of a code (Product ID) which is generated
based on the hardware on which the product is installed. No personal data are used to generate the code and the user remains
completely anonymous.
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ABBYY FlexiCapture 9.0 license activation wizard

The Activation Wizard will guide you through the activation process.

Inorder to use ABBYY FlexiCapture 9.0, you must activate the obtained license.

Selecta license activation method:

(@) via Intemet (recommended)
) by e-mail
C' by e-mail from another computer

If you have obtained an Activation File, please load your Activation File:

C' load activation file

< Back ” Next > l l Cancel l

The following activation methods are available:

. vialnternet - activation is carried out automatically and takes several seconds to complete; this method requires an active
Internet connection

« by e-mail - an e-mail message is generated that contains the data required for activation; please do not alter the body or the
subject of the message to ensure a prompt reply from the mail robot

« by e-mail from another computer - an e-mail message is generated that contains the data required for activation; you
can use this method if the Protection Server is not connected to the Internet and e-mail messages cannot be sent from it

«  load activation file — connect an activation file you received by e-mail in response to an activation request
Once the activation is complete, ABBYY FlexiCapture 9.0 can be used on the server on which it was activated.

You can re-install ABBYY FlexiCapture 9.0 as many times as you need without additional activations (provided the Protection Server is
not re-installed).

Note:
1. ABBYY FlexiCapture stations automatically connect to the Protection Server and use the installed license.

2. Ifyou re-install the Protection Server on a different computer, you will need to re-activate your licenses (in the case of a li-
cense file) and change the address of the Protection Setver in the Protection.ini file on the stations (see the “Connecting sta-
tions to the Protection Server” section for details).

3. If there are no free activated licenses available on the Protection Server and a user tries to run the program on their work-
station, the program will not start and a warning message will be displayed.

4. Hardware licenses can only be activated over the Internet.

Connecting stations to the Protection Server

All the stations installed in the system access the Protection Server. The address of the Protection Server is stored in the Protection.ini
file, which can be found here:

%:\Documents and Settings\All Users\Application Data\ABBYY\FlexiCapture\9.0\Licenses
Windows Vista:
%:\ProgramData\ABBYY\FlexiCapture\9.0\Licenses\Protection.ini

The address of the server is specified in this line:

ServerName=old_server

To enable a station to access a new Protection Server, simply change the old name to the name of the computer where the Protection
Server is installed.
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The same applies to the standalone version of ABBYY FlexiCapture 9.0. If you have one license and several operator stations, specify
the address of the computer where the license is stored in the Protection.ini files on the workstations.

The Scanning Station and the Data Verification Station get licenses from the Application Server. The Processing Server connected to
the Application Server must be running for you to get a license.
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Setting Up FlexiCapture 9.0 Distributed Installation

Setting up the system
Once the license is installed and activated, you should set up the system:

1. Open the Administration and Monitoring Console. Create a database. To use a file storage folder, select the corresponding
option and provide the path to the folder. This should be a local folder on the Application Server.

Note: If no file storage folder is used, all project files are stored in the database. In terms of efficiency and security, the two approaches
are equal. Storing the project files in the databases makes backing up and restoring data easier but increases the size of the database,
which may be crucial if you use Microsoft SQL Server Express Edition, as it limits the size of the database to 4 GB.

ABBYY' FlexiGapture 9.0

Administration and Monitoring Console EReaan

Home Monitoring Reports Settings Help
Create new database

5QL Server instance name: sokolovisglexpress
Database name: FC111

Authentication to access server

Authentication settings Windows Authentification v

Use external file storage

Path:
D:\TempFC

OK Cancel

Help Technical support www.abbyy.com About ABBYY FlexiCapture 9.0

2. Upload your project to the Application Server by starting the Project Setup Station and doing the following:
3. Create a new project (File>New Project...). Create or import at least one document definition (Project->Document
Definitions).

4. Open one of the samples (available at <disk>:\\Documents and Settings\All Users\Application
Data\ABBYY\FlexiCapture\9.0\Samples, for Microsoft Windows Vista -
<disk>:\\Users\Public\ABBYY\FlexiCapture\9.0\Samples).

5. Opena project you created in ABBYY FlexiCapture 8.0 Professional.

6. Open a new project and import a batch you created in FormReader 6.5 DE or EE.

For the correct operation, the project should contain at least one correct and connected document definition for which ex-
port settings have been specified.

Next, upload the project to the Application Server (File->Upload Project to Server...).

7. In the Administration and Monitoring Console, select Settings-> Users and Groups. In the Project list, select the name of
the created project.
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Note: The user that created the database had the administrator rights and may start any stations and perform any types of operations.
You cannot divest the creator of the database of their administrator rights.

8. Toadd a user, type their name in the Add field and click User.

9. To change a user’s access rights, find the user in the list and click on the corresponding link. Specify the roles of the user. For
the Data Verification Operator, Verification Operator, Senior Verification Operator, and Scanning Operator roles, you must
also specify the batch types accessible to the user. The other roles may access all batch types.

ABBYY' FlexiGapture 9.0

Administration and Monitoring Console

Russian
Home Monitoring Reports Settings Help
Project:|SingIeEntryPoint v| Last updated:7/29/2009 4:12:31 PM Refresh
Add User

| | H |User name:
v Users Permissions

FINE\PSokolov
FINE\Sokolovs$

Permissions for all projects
O Processing server
> Groups O Monitoring Operator
Administrator
Permissions for current project
Role Batch types
[0 Scanning Operator
O Data Verification Operator
O Verification Operator
O Senior Verification Operator
O Project Settings Editor

User groups
Member of user groups: User groups:

10. Ifrequired, created user groups and grant them the necessary access rights. Using groups saves time and makes user man-
agement easier.

Note: The Administrator, Monitoring Operator, and Processing Server roles can be assigned without creating a project in the database.

The other roles require access rights to specific projects, therefore you need to create at least one project before you can assign those
roles.

Important! The account of the computer on which the Processing Server runs must be added to the list of users with the Processing
Server role. If this computer is part of 2 domain, the account will look like this: <Domain Name>\<Computer Name>$ (e.g.
Fine\quad-18). Subsequently, the Processing Server will automatically control the Processing Stations, their access rights, etc.

11. Start the Processing Server Monitor (Start->ABBYY FlexiCapture 9.0 Servers->Processing Server) and set up the
server:

12. Select Actions->Properties and specify the address of the Application Server (e.g. http://ApplicationServer).

=
13. Start the Processing Server by clicking EC ) .

14 . Add Processing Stations by selecting Stations in the tree and clicking . Add the names of the stations or locate them
in the LAN:
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&) Processing Server Monitor - SOKOLOV

File  Actions

& = @ l_f ”I @ (@  Max. number of processes: __,é__ﬁ_. 4+ X

= [@ ABBYY FlexiCapture 9.0 Serv|| #
= a; SOKOLOV 1

Start automat...  Max. 1

Add Stations Yes 3

Stations Browese for the stations you want to add.

[ Tasks Browse for Computer

Choose the computer you want to add:

=] ifi Fine

j lcsry

- 4randot
-1 2003t

) Abbyy-7c8002a15
. 1) Abbyy-cal
- 1§ Abbyy-temp
- B Adt

1) Afanasyev
i Afanasyeva
- '§ Agafonav
- Agafonova

.. W Anisheva
< il |

L=

|«

[+

< 1]

Add processing station.

[~
[~

1l ?

Then select the stations in the list displayed in the main window of the Processing Server Monitor and click IE .

5. If Hot Folders are to be used for image import in any of the projects, connect these folders in the node of the same name:

E’; Processing Server Monitor - SOKOLOV |:||E”g|
File Actions

= @ ABRBYY FlexiCapture 9.0 Serv|| Faor Project

= SoKoLOV v
X Hot Folders « Ban
@ Stations S
-] Tasks Export List...
Select Al Ctri+A
< i | % i [ b

Enable hot folders for selected project(s).

6 . If required, specify the general project processing options on the Project Setup Station (“Default” batches, Project->Project
Properties..., Workflow tab). If several batch types are used, specify the processing parameters for each batch type: select
Project->Batch Types..., select the desired type, click Edit... and then click the Workflow tab.

Setting up Microsoft Internet Information Server (11S)

The Application Server can only be installed on 2 computer on which Microsoft Internet Information Server 5.1, 6 or 7 is installed. IIS is
required for the correct operation of the Application Server and the Administration and Monitoring Console.

Checking the operation of IS

To check the operation of IIS, start it by selecting Start->Control Panel->Administrative Tools-> Internet Information Ser-
vices. If a problem occurs when starting IIS, the following message will be displayed: “Unexpected error 0x8ffe2740 occurred” for v.
5.1 (Windows XP) or “The process cannot access the file because it is being used by another process” for v. 6.0 (Windows 2003) and v.
7.0 (Windows 2008).
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This error message means that port 80 is in use. To find out which application is using the port, do the following:

1. Inthe command line (Start->Run), type
netstat -anop TCP/find ":80"
The list of connections to port 80 will be displayed and the ID of the corresponding process in the following format:
TCP 0.0.0.0:80 00.00:0 LISTENING 1264

2. Type
tasklist /SVC /FI "PID eq 1264"
replacing 1264 with the ID of the process obtained at step 1. The result will be displayed in the following format:
Image Name PID  Services

Virus.exe 1264 KillMePlz

3. End the process that uses the port.
Important! Do not switch IIS over to another port, as you will not be able to start the Application Server in this case.

Setting Up IIS

AlLIIS versions (5.1, 6.0, 7.0)
The default site (i.e. the site with the identifier 1) should contain the virtual folder Default Web Site\FlexiCapture\Server with the
following objects:
«  DatabaseManager.dll
. DBInitFillsgl
«  Descriprion.sql
. FineObj.dll
. FlexiCaptureWebServices.disco
. FObjEventSrc.dll
. msver71dl
. web.config
. WebServicesdll
. WebServiceshtm

. WebServiceslsapi.dll

ABBYY FlexiCapture 9.0 Server must be associated with this folder. In Scripts and Executable, the execute permissions should be
set up.

The following mapping should be specified in the application settings: .dll >
C\Inetpub\wwwroot\FlexiCapture\Server\WebServicesIsapi.dll.

For the default mode (ie. all stations in the domain), anonymous access must be prohibited and integrated windows authentication
must be turned on.

Basic authentication must be turned on to enable a login/password-based connection of a Remote Scanning Station.
You can use the HTTPS protocol for greater security. To use HTTPS, enable SSL support in the IIS.

IIS 6.0 and later
You must explicitly allow the isapi extension, which corresponds to the server (FlexiCapture Web Services-> WebServicesIsapi).

A separate poll of processes must be created for the application (the recommended number of processes in the pool is three; for IIS 7.0,
the pool should be a classic-mode 32-bit pool).

When installing on Windows Server 2003 and Windows Server 2008, the performance may be extremely low. If this is indeed the case,
adjust this registry branch as shown below:

HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\Interfaces.
Inside each GUID, create TcpAckFrequency = 1 of type DWORD.

I1S 7.0
For normal error diagnostics, allow detailed errors in all cases (Server->Error Pages->Detailed Errors).
Remove the ISAPLAIl module from the list of allows modules (it is incompatible with our isapi extension).

To make the location of errors easier, consult the following fragment of applicationHost.config (see
<disk>:\Windows\System32\inetsrv\config) obtained after installing IIS 7.0:
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<configuration>

<applicationPools>

<add name="FlexiCapture Web Services" managedPipelineMode="Classic">
<processModel identityType="NetworkService" maxProcesses="3" />
</add>
</applicationPools>

<sites>

<site name="Default Web Site" id="1" serverAutoStart="true">

<application path="/FlexiCapture/Server" applicationPool="FlexiCapture Web
Services">

<virtualDirectory path="/" physical-
Path="C:\inetpub\wwwroot\FlexiCapture\Server\" />

</application>
</site>
</sites>

<security>
<isapiCgiRestriction notlListedIsapisAllowed="false" notListedCgisAllowed="false">
<clear />

<add
path="C:\Windows\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" allowed="true"
groupId="ASP.NET v2.0.50727" description="ASP.NET v2.0.50727" />

<add
path="C:\inetpub\wwwroot\FlexiCapture\Server\WebServicesIsapi.dll" allowed="true"
groupld="FlexiCaptureWebServices" description="FlexiCapture Web Services" />

</isapiCgiRestriction>
</security>

<location path="Default Web Site/FlexiCapture">
<system.webServer>
<directoryBrowse enabled="false" showFlags="None" />
<handlers accessPolicy="Read, Execute" />
<httpLogging dontLog="false" />
<security>
<authentication>
<windowsAuthentication enabled="true" />
<anonymousAuthentication enabled="false" />
<digestAuthentication enabled="false" />
<basicAuthentication enabled="false" />
</authentication>
</security>
<defaultDocument enabled="true">
<files>
<clear />
<add value="DefaultPage.aspx" />
</files>
</defaultDocument>
<httpErrors>
<clear />
</httpErrors>
<asp>
<session timeout="00:20:00" />
<limits scriptTimeout="00:01:30" />
</asp>
</system.webServer>
</location>

<location path="Default Web Site/FlexiCapture/Server">

© 2009 ABBYY. All rights reserved.
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<system.webServer>
<directoryBrowse enabled="false" showFlags="None" />
<handlers accessPolicy="Read, Execute">
<clear />

<add name="rules-Integrated" path="*.rules" verb="*"
type="System.ServiceModel.Activation.HttpHandler, System.ServiceModel, Version=3.0.0.0, Cul-
ture=neutral, PublicKeyToken=b77a5c561934e089" preCondition="integratedMode" />

<add name="xoml-Integrated" path="*.xoml" verb="*"
type="System.ServiceModel.Activation.HttpHandler, System.ServiceModel, Version=3.0.0.0, Cul-
ture=neutral, PublicKeyToken=b77a5c561934e089" preCondition="integratedMode" />

<add name="svc-Integrated" path="*.svc" verb="*"
type="System.ServiceModel.Activation.HttpHandler, System.ServiceModel, Version=3.0.0.0, Cul-
ture=neutral, PublicKeyToken=b77a5c561934e089" preCondition="integratedMode" />

<add name="ISAPI-dll" path="*.dll" verb="*" modules="IsapiModule" resour-
ceType="File" requireAccess="Execute" allowPathInfo="true" />

<add name="TraceHandler-Integrated" path="trace.axd" verb="GET,HEAD,POST, DEBUG"
type="System.Web.Handlers.TraceHandler" preCondition="integratedMode" />

<add name="WebAdminHandler-Integrated" path="WebAdmin.axd" verb="GET, DEBUG"
type="System.Web.Handlers.WebAdminHandler" preCondition="integratedMode" />

<add name="AssemblyResourceLoader-Integrated" path="WebResource.axd"
verb="GET, DEBUG" type="System.Web.Handlers.AssemblyResourceLoader" preCondition="integratedMode"
/>

<add name="PageHandlerFactory-Integrated" path="*.aspx" verb="GET,HEAD, POST, DEBUG"
type="System.Web.UI.PageHandlerFactory" preCondition="integratedMode" />

<add name="SimpleHandlerFactory-Integrated" path="*.ashx"
verb="GET, HEAD, POST, DEBUG" type="System.Web.UI.SimpleHandlerFactory" preCondition="integratedMode"
/>

<add name="WebServiceHandlerFactory-Integrated" path="*.asmx"
verb="GET, HEAD, POST, DEBUG" type="System.Web.Services.Protocols.WebServiceHandlerFactory, Sys-
tem.Web.Services, Version=2.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a" preCondi-
tion="integratedMode" />

<add name="HttpRemotingHandlerFactory-rem-Integrated" path="*.rem"
verb="GET, HEAD, POST, DEBUG" type="System.Runtime.Remoting.Channels.Http.HttpRemotingHandlerFactory,
System.Runtime.Remoting, Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" pre-
Condition="integratedMode™ />

<add name="HttpRemotingHandlerFactory-soap-Integrated" path="*.soap"
verb="GET, HEAD, POST, DEBUG" type="System.Runtime.Remoting.Channels.Http.HttpRemotingHandlerFactory,
System.Runtime.Remoting, Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" pre-
Condition="integratedMode™ />

<add name="rules-ISAPI-2.0" path="*.rules" verb="*" modules="IsapiModule"
scriptProcessor="C:\Windows\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" preCondi-
tion="classicMode, runtimeVersionv2.0,bitness32" />

<add name="xoml-ISAPI-2.0" path="*.xoml" verb="*" modules="IsapiModule"
scriptProcessor="C:\Windows\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" preCondi-
tion="classicMode, runtimeVersionv2.0,bitness32" />

<add name="svc-ISAPI-2.0" path="*.svc" verb="*" modules="IsapiModule" scriptProc-
essor="%SystemRoot%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" preCondi-
tion="classicMode, runtimeVersionv2.0,bitness32" />

<add name="AXD-ISAPI-2.0" path="*.axd" verb="GET,HEAD, POST, DEBUG" mod-
ules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet isapi.dll"
requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0,bitness32" responseBuffer-
Limit="0" />

<add name="PageHandlerFactory-ISAPI-2.0" path="*.aspx" verb="GET,HEAD, POST, DEBUG"
modules="IsapiModule" scriptProces-
sor="%windir%\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" requireAccess="Script" preCon-
dition="classicMode, runtimeVersionv2.0,bitness32" responseBufferLimit="0" />

<add name="SimpleHandlerFactory-ISAPI-2.0" path="*.ashx"
verb="GET, HEAD, POST, DEBUG" modules="IsapiModule" scriptProces-
sor="%windir%\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" requireAccess="Script" preCon-
dition="classicMode, runtimeVersionv2.0,bitness32" responseBufferLimit="0" />

<add name="WebServiceHandlerFactory-ISAPI-2.0" path="*.asmx"
verb="GET, HEAD, POST, DEBUG" modules="IsapiModule" scriptProces-
sor="%windir%\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" requireAccess="Script" preCon-
dition="classicMode, runtimeVersionv2.0,bitness32" responseBufferLimit="0" />

<add name="HttpRemotingHandlerFactory-rem-ISAPI-2.0" path="*.rem"
verb="GET, HEAD, POST, DEBUG" modules="IsapiModule" scriptProces-
sor="%windir%\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" requireAccess="Script" preCon-
dition="classicMode, runtimeVersionv2.0,bitness32" responseBufferLimit="0" />

<add name="HttpRemotingHandlerFactory-soap-ISAPI-2.0" path="*.soap"
verb="GET, HEAD, POST, DEBUG" modules="IsapiModule" scriptProces-
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sor="%windir%\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll" requireAccess="Script" preCon-
dition="classicMode, runtimeVersionv2.0,bitness32" responseBufferLimit="0" />

<add name="AboMapperCustom-58782" path="*.dl11l" verb="*" modules="IsapiModule"
scriptProcessor="C:\inetpub\wwwroot\FlexiCapture\Server\WebServicesIsapi.dll" responseBuffer-
Limit="0" />

<add name="TRACEVerbHandler" path="*" verb="TRACE" modules="ProtocolSupportModule"
requireAccess="None" />

<add name="OPTIONSVerbHandler" path="*" verb="OPTIONS" mod-
ules="ProtocolSupportModule" requireAccess="None" />

<add name="StaticFile" path="*" verb="*" mod-
ules="StaticFileModule, DefaultDocumentModule, DirectoryListingModule" resourceType="Either" re-
quireAccess="Read" />

</handlers>
<httpLogging dontLog="false" />
<security>
<authentication>
<windowsAuthentication enabled="true" />
<anonymousAuthentication enabled="false" />
<digestAuthentication enabled="false" />
<basicAuthentication enabled="false" />
</authentication>
</security>
<defaultDocument enabled="true">
<files>
<clear />
<add value="WebServices.htm" />
</files>
</defaultDocument>
<httpErrors>
<clear />
</httpErrors>
<asp>
<session timeout="00:20:00" />
<limits scriptTimeout="00:01:30" />
</asp>
</system.webServer>
</location>

</configuration>

Security settings

Major scenario
Conditions:
. All participants (computers and users) are in a domain.
Features:
. Requires minimum additional settings.
Actions:
1. After the system is installed, the administrator of the computer on which the Application Server is installed creates a database

and becomes the administrator of the system. The administrator may change the settings of the Application Server, upload
projects to the Application Server, and grant access rights for projects.

2. The administrator may grant administrator rights to another user, thereby delegating the administration of the system to that
user.

3. The administrator grants the Processing Server rights to the computer on which the Processing Server is installed (in the
format <Domain Name>\ <Computer name>3$ by default if the Processing Server operates as the Network Service; or a spe-
cially created domain account that is assigned to the Processing Server). If required, the administrator may create and set up
special accounts for the Processing Stations.

4. The administrator uploads the projects and assigns roles to the operators.
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Some of the stations are not in the domain

Conditions:

Some of the stations (Scanning Stations, Verification Stations) operate remotely.

Features:
«  NTLM pass-through authentication is used. General principle: to enable user of computer M2 (account M2 /Uset{password])
to authorize on computer M1, you must duplicate this account (with the same password) on computer M1, ie. create
M1 /User[password].
. The Processing Stations must be in the same domain as the Application Server.
Actions:
1. Do the steps of the major scenario above.
2. On the Application Server, create accounts corresponding to the remote users. On the remote stations, create identical ac-
counts (same names and passwords) and run the stations under these accounts.
Work group
Conditions:

The stations and the servers are in a work group.

Features:

Actions:
1.
2.

NTLM pass-through authentication is used. General principle: to enable user of computer M2 (account M2/User[password])
to authorize on computer M1, you must duplicate this account (with the same password) on computer M1, i.e. create
M1 /User[password].

Basic authentication must be turned on in ISS to enable export from the Scanning Station by explicitly specifying the user’s
login and password.

Perform steps 1, 2 of the major scenario above.

On the computer on which the application Server is installed, create a local account for the server. In the IIS settings, specify
that the pool of FlexiCapture Web Services should run under this account.

Set up the Administration and Monitoring Console: in the IIS settings, go to the ASP.NET page and specify an account for the
FlexiCapture virtual folder (either the same account as in step 2 or a separate account).

If the database is located on a computer other than the Application Server, copy the accounts from steps 2 and 3 onto the
computer hosting the database. Additionally, duplicate the account of the administrator on the computer hosting the data-
base. The Administration and Monitoring Console will be run under this account in order to set up the Application Server (to
connect to the database).

Use the administrator account to run the Administration and Monitoring Console and create a new database.

On the computer on which the Processing Server is installed, create an account for it. Specify this account in the Processing
Server settings. Duplicate this account on the computer on which the Application Server is installed.

In the Administration and Monitoring Console, assign the Processing Server role to the Processing Server account (created
at step 6).

If the Processing Stations run on separate computers, create accounts for them and duplicate them on the Processing Server.

On the computer on which the Application Server is installed, duplicate the accounts of all users that should have access to
the system and assign roles to the users in the Administration and Monitoring Console.

Without authorization

Conditions:

Features:
Actions:
1.

Connection between the servers and the stations has been established.
No authorization.
Perform steps 1-4 of the Work Group scenario for connecting the database to the server (if the database is not located on

the same computer as the Application Server).

Create a database and explicitly specify the user’s login name and password.
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3. On the computer on which the Application Setver is installed, allow anonymous login in the IIS settings. In the Administra-
tion and Monitoring Console, assign all the roles to the anonymous account (of type IUSR_XXX) specified in IIS.

Database settings

By default, an Oracle database allows a maximum of 40 processes and 49 sessions. When these limits are reached, errors will occur.
If required, increase the default values by using a script similar to the following:
connect sys/<Login> as sysdba;

alter system set sessions=<SessionCount> scope=spfile;
alter system set processes=<ProcessCount> scope=spfile;
shutdown immediate;

startup;

33



Logging

Administration and Monitoring Console logs

The event and error logs available in the Administration and Monitoring Console are the main logs that register errors that occur in the
system in general. These logs record all errors that occur during document processing and affecting the processing and all events that
occur during document processing. To view the logs, select Monitoring->Event Log and Monitoring->Error Log in the Admini-
stration and Monitoring Console.

Task processing logs on the Processing Servers

The Processing Server logs the processing of the tasks. The list of the active tasks and their logs can be accessed via the Processing
Server Monitor. To view a task log, select Actions=>View Log... when selecting the task.

OS event logs on the servers

The server components (Application Server, Processing Server, and Processing Stations) log errors and warnings in the local event log
of the operating system under which they are running (section: Application, sources: FlexiCapture Web Services and FlexiCapture
Processing Server). These logs can be accessed by the administrators both locally and remotely via the standard Event Viewer tool of
the MMC console.

The local OS event log records not only processing errors, but also all errors in the operation of the server components not directly
related to the processing of documents. This log will list processing errors even if the Application Server is inaccessible at the time of
error and the error cannot be logged in the ABBYY FlexiCapture log.
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Technical Support

Should you have any questions regarding the installation and use of ABBYY FlexiCapture 9.0, please contact the ABBYY technical sup-
port service or the technical support service of the ABBYY partner from which you obtained the software. For contact details, see the
Technical Support section of the ABBYY website at www.abbyy.com.
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